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General Information

Purpose

This document walks you through the process of installing the PLATO
Pathways system for a standalone configuration.

System
requirements

Your workstations should meet PLATO Pathways system and configuration
requirements. Requirements are updated occasionally. Always refer to the
requirements page at http://support.plato.com/requirements.asp on the
PLATO Support Services web site for the most current requirements.

Note to Windows Vista™ users

Some details of the operation of PLATO Pathways on Windows Vista
operating systems differ slightly from the operation on Windows" 2000 or XP
workstations. While the installation process is the same for all standalone
workstations, you may want to refer to the PLATO® Pathways User’s Guide
for Windows Vista™ document in this kit for information regarding
courseware function, usability, etc.

Materials

Along with this document, you will need the following to install PLATO
Pathways:

e PLATO Pathways version 4.3 CD (located behind the PLATO Pathways
Installation Materials tab of the kit)

e Courseware/License Install CD-ROM (located behind the Courseware
Installation Materials tab)

Continued on next page
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General Information, Continued

Knowledge
requirements

Knowledge requirements to install PLATO Pathways for a standalone
configuration include the following:

¢ You have a working knowledge of your workstation operating system
interface, including how to use the mouse, navigate through screens and
menus, choose options, and find files or folders.

¢ You know how to disable screen saver, antivirus software, and security
programs if they are running on the workstation.

¢ You know how to log on to your workstation as an administrator.

¢ You know how to check your workstation's system date and time, and
change them if needed.

¢ You know how to determine hard drive space available for installing
PLATO Pathways system and courseware.

¢ You know how to install software from a CD-ROM.

¢ You know how to run a backup of your system.

¢ You should be familiar with Windows XP Autoplay feature, if you are
using Windows XP.
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Installing PLATO Pathways

Before you To prepare your system for the installation, follow the steps below.
install
Step Action
1 Close any applications and disable any screen saver, antivirus
software, or security software programs that are running on your
workstation.
2 Verify your workstation's system date and time are correct.
How to To install PLATO Pathways, follow the steps below.

Note These instructions are for installing PLATO Pathways version 4.3 for
a standalone configuration.
Step Action
1 Log on to the workstation as an administrator.
2 Put the PLATO Pathways version 4.3 CD-ROM into your CD-
ROM drive.
3 Refer to the table below to determine your next step.

If... Then...
the Adobe® Acrobat™ go to step 4.
License Agreement
window displays,
the Adobe Acrobat use My Computer or Windows
License Agreement Explorer to navigate to the CD-
window does not ROM drive. Double-click
display, SETUP.EXE. Go to step 4.
a message displays click OK to restart your system.
indicating you must Repeat steps 1 and 2, and then go to
update settings, step 4.

Continued on next page
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Installing PLATO Pathways, Continued

How to (continued)

Step Action
4 Click OK to accept the Adobe Acrobat License agreement.
5 Click Next on the Welcome screen.
Result
The Select Destination Directory screen displays.
6 Verify the amount of disk space available on your system.

If... Then...
a negative “Free Disk | click Cancel to exit the installation.
Space After Install” You do not have the required 100
number displays, MB of free disk space.
you have the required | go to step 7.
100 MB of free disk
space,
7 Accept the default installation directory: C:\PWAY. If this
directory does not default, browse to it. Click Next.
8 Click Next after being prompted to close all programs.
9 Click Next on the “Ready to Install Windows” dialog box and

follow the prompts to complete the installation.

Result

The system begins to copy PLATO Pathways files from the CD-

ROM to your system.

Note

During the setup process, some workstations may generate a
dialog box displaying the message “Confirm File Replace.” Select
the No to all option. The installation continues.

Continued on next page
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Installing PLATO Pathways, Continued

How to (continued)

Step Action
10 | Refer to the table below to determine your next step.

If... Then...
the workstation from which | select the Full-screen using
you are installing PLATO DirectX option. Click Next.
Pathways has DirectX”
installed,
you are not sure whether the | select the Don't use full-
workstation from which you |screen option. Click Next.
are installing PLATO
Pathways has DirectX
installed,

Result
The installation automatically continues.

Note You can change your full-screen options later, once you
determine whether DirectX is installed on your system. For
more information about doing so, refer to Appendix B:
Using the Full-Screen Option on page 13.

11 | Select Yes to install a PLATO Pathways shortcut icon on your

desktop.

12 | Follow prompts to install QuickTime" 6. We recommend you

accept all of the default settings.

Note If you receive a prompt stating that you have a newer
version of QuickTime, click OK to continue—do not
uninstall the QuickTime version you have.

13 | Click Next on the Indeo” Video Interaction Setup screen. Often,

this screen is automatically minimized.

14 | Click Yes to accept the license agreement.

15 | Click OK to accept the drivers.

16 | Click No on the “read release notes” message.

Continued on next page
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Installing PLATO Pathways, Continued

How to (continued)

Step Action

17 Click OK on the “Installation Finished” dialog box to exit the
installation program.
19 Click OK when prompted to restart your system.
20 Set up user pathways. Refer to Appendix A: Setting up Pathways
User Account on page 9 for instructions.
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Backing Up PLATO Pathways

Introduction

Once you install PLATO Pathways and configure your workstations as
needed, you should back up the entire \PWAY folder, including all its files
and subfolders.

Note If you installed courseware to custom locations you should back up
those folders as well.

Frequency

Make sure you or your network administrator run frequent backups on a
routine basis. As part of your backup routine, you may wish to run a
minimum backup instead of a full backup of PLATO Pathways from time to
time.

What should I
back up?

At a minimum, you must back up the following files and folders on each
workstation:

¢ :\PWAY\DB (contains user information, student data)
¢ :\PWAY\PRIVATE (contains user information, student data)
¢ :\PWAY\PRIVDB (contains user information, student data)
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Appendix A: Setting Up a Pathways User Account

Introduction This appendix explains how to set up a pathways user account, create a
Pathways shortcut icon, and provide correct permissions for students using
standalone workstations.

Purpose Windows" security requires a special user account to allow students to access
the PLATO Learning System on their standalone workstations.

How to You must complete the following tasks at each workstation that students will
use to run PLATO Pathways.

e Create a pathways user account.
e Add a local user profile.
e Assign correct permissions to students using SETPERMS.VBE.

Task 1 — Create a Local User Account Named pathways

Step Action
1 Log onto the workstation as administrator.
2 Refer to the table below to determine your next step.

If... Then...
you are a right-click My Computer, and then click
Windows 2000 Manage. Go to step 3.
user,
Result
The Computer Management window
displays.
you are a select Start>Control Panel>User
Windows XP or Accounts. Go to step 4.
Windows Vista
user,

3 Click Local Users and Groups (in the Computer Management list
displayed at the left).

Continued on next page
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Appendix A: Setting Up a Pathways User Account, Continued

How to (continued)

Task 1 continued

Step Action
4 Refer to the table below to determine your next step.
If... Then...
you are a right-click Users and then click New
Windows 2000 User.
user,
Result
A New User window displays.
you are a click Create an Account.
Windows XP user,
you are a click Manage another account, then
Windows Vista click Create a new account.
user,
5 Enter pathways as the Username.
6 Click Create or Create Account.
Result
The pathways user is automatically created.
7 Click Close.
8 Exit the Computer Management screen.
9 Log off the workstation as an administrator.

Task 2 — Add a Local User Profile

Step Action
10 | Log on to the workstation as the user pathways. (Enter
“pathways” as your Username.)

Result
A local user profile for the user pathways is automatically created.
11 Log off the workstation as the user pathways.

Continued on next page

10
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Appendix A: Setting Up a Pathways User Account, Continued

How to (continued)

Task 3 — Assign Correct Permissions

Step | Action

12 | Log back on to the workstation as an administrator.

13 Open My Computer. Click the Tools menu, and then click Folder
Options > View tab > Show Hidden Files and Folders > OK.

For Vista users: Open Computer, then click the Organize tab >
Folder & Search Options > View tab > Show Hidden Files and
Folders > Apply.

14 | Locate and double-click the SETPERMS.VBE file located in the
Tools folder of your PLATO Pathways 4.3 CD-ROM to execute
the SETPERMS utility.

15 | If you have already installed all of your PLATO courseware, click
Yes to continue.

Result

A message displays, explaining what the SETPERMS utility will
do.

16 | Click Yes to continue.

17 Select the drive on which PLATO Pathways is installed, then click
OK.

18 Enter the User or Group used for PLATO Pathways, then click
OK.

Result
A message displays, reporting that permissions will be set for the
user/group specified.

Continued on next page

11
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Appendix A: Setting Up a Pathways User Account, Continued

How to (continued)

12

Task 3 continued

Step | Action

19 Click Yes to continue.
Please wait while the utility runs. When the utility is finished, the
following message displays:
Workstation permissions are now set for user/group..
Click OK to exit.

20 Click OK.

21 Verify that all users have full access rights to the C:\PWAY
folder.

22 Repeat steps 13-20 and run SETPERMS on each workstation that

needs to be configured to run PLATO Pathways.

Note

If you see a message stating that the system was unable to move
the current user’s PLATO Pathways icon to the All Users Desktop,
either the PLATO Pathways shortcut was not found in the current
user’s desktop folder or is already in the All Users folder.

If the shortcut does not appear in the C:\Documents and
Settings\All Users\Desktop folder, then you must move the
shortcut to that location from where it was installed.
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Appendix B: Using the Full-Screen Option

Introduction

DirectX

Graphical
Device
Interface (GDI)

Recommended

When you run the setup program (WSETUP.EXE) for the first time at a
workstation, you are prompted to choose a full-screen option. The full-screen
option allows you to display your Windows-based PLATO courseware in a
full-size window using Microsoft DirectX® or GDI.

DirectX was created by Microsoft to give multimedia-rich programs better
and faster performance. You may or may not already have DirectX installed
on your Windows workstation.

Graphical Device Interface is a Windows standard for representing graphical
objects and transmitting them to output devices, such as monitors and
printers.

We recommend using the latest version of DirectX if you want to allow your
PLATO Courseware to run in a full size-window.

Note
Using GDI to change your screen size or resolution may alter the entire
desktop.

Continued on next page
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Appendix B: Using the Full-Screen Option, Continued

Turning off the
Full-Screen
option

14

If you want to turn off your full-screen option, or try a different option, follow
the steps below at the workstation.

Step Action

1 At the workstation you want to change, disable any screen saver,
antivirus software, or security software programs you have
running.

2 Windows 2000/XP users: Open the C: drive in My Computer or
Windows Explorer, then open the \WINDOWS or \WINNT folder.
Windows Vista users: Open the C: drive in Computer.

3 Windows 2000/XP users: Right-click on the \PWAY folder, and
then click Delete.

Windows Vista users: Right-click on the C:\LPWAY folder, and
then click delete. Proceed to step 5.
4 Windows 2000/XP users only: Delete the

CA\WINNT\WCMIWS.INI file or
CAWINDOWS\WCMIWS.INI file.

Continued on next page
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Appendix B: Using the Full-Screen Option, Continued

Turning off the Full-Screen option (continued)

Step

Action

5

Use My Computer or Windows Explorer to navigate to the drive
PLATO Pathways is installed on, and then open the \PWAY
folder. Double-click WSETUP.EXE.

Result
The workstation setup program starts and the Full-Screen Update
Installation dialog box displays.

Select WPCD23 Full-Screen
Display Type

Please select the full-screen option you desie for this
wiorkstation:

* Full-screen using Diectd
" Full-screen using GDI
" Don't use ful-scieen option

Choose the option you want, then click Next.

Click Yes when you are prompted to create a Pathways shortcut
icon on the desktop.

Follow the prompts to complete the QuickTime installation. We
recommend that you accept the default settings.

Note If you receive a prompt stating you have a newer version of
QuickTime, click OK to continue—do not uninstall the
QuickTime version you have.

Restart your workstation when you are prompted to do so.

15
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Appendix C: Contacting PLATO Support Services

Introduction If you have a software support contract with PLATO Support Services, you
have a number of options to help you keep your PLATO system running
smoothly. These options include a support website, email access, software
upgrades and courseware enhancements, and a help desk staffed by
experienced analysts.

Preparation If you contact PLATO Support Services, please be prepared to provide your
unique PLATO ID number that is included on a set of stickers behind the
Support Services tab in your PLATO Pathways kit.

If you cannot locate your unique PLATO ID, please email
support@plato.com to request your ID number and sticker set.

Methods of If you experience problems or have questions at any time, you can contact
contacting PLATO Support Services using the following methods:

PLATO

Support

e Web site: http://support.plato.com
e Submit an e-mail request: http://support.plato.com/email
e Phone number: 800.869.2200

Services

17
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